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ขอมูลเกี่ยวกับแอปพลเิคชั่นเพิ่มเติมสําหรับ Nokia N73

คณุจะพบแอปพลเิคชั่นเพิ่มเติมจาก Nokia และบริษทัอื่นๆ ไดจากหนวยความจําของโทรศัพท
และบนแผนซีดีรอมที่มาพรอมกับโทรศพัทของคณุ 

ไมมีการรับประกัน

แอปพลเิคชั่นของบริษทัอื่นที่มาพรอมกับโทรศัพท อาจถูกสรางขึ้นและอาจเปนของบคุคลหรือนิติบคุคลที่ไมใช

กิจการในเครือหรือมีสวนเกี่ยวของกับ Nokia และ Nokia ไมไดเปนเจาของลขิสทิธิ์ และ/หรือสทิธิ์ในทรัพยสนิ
ทางปญญาของแอปพลิเคชั่นจากผูผลติรายอื่นเหลานี้ ดังนั้น Nokia จึงไมมีสวนรับผดิชอบในการใหการสนับสนุนผูใช 
ความสามารถในการใชงานของแอปพลเิคชั่นเหลานี้ หรือขอมูลทีแ่สดงในแอปพลเิคชั่นหรือสือ่เหลานี้ นอกจากนี้ Nokia 

ไมไดใหการรับประกันใดๆ สําหรับแอปพลเิคชั่นของบริษัทเหลานี้ คุณตกลงยอมรับวาซอฟตแวร และ/หรือแอปพลเิคชั่น 

(รวมเรียกวา "ซอฟตแวร") ใหมา "ตามสภาพจริง ณ ปจจุบนั" โดยปราศจากการรับประกันใดๆ ทั้งสิ้น 
ไมวาจะระบุไวอยางชัดแจง หรือโดยนัยในทุกกรณี และภายใตบทบัญญตัิแหงกฎหมายสงูสุด 

ทั้งโนเกียรวมทั้งบริษัทพันธมิตรจะไมใหการรับประกันใดๆ ไมวาจะระบไุวอยางชัดแจง หรือโดยนยัในทุกกรณี 
รวมถึงแตไมจํากัดเฉพาะการรับประกันของชื่อสินคา โอกาสทางการคา หรือความเหมาะสมของวัตถุประสงคพิเศษ 
หรือรับประกันวาซอฟตแวรนี้จะไมลวงละเมิดการจดสิทธิบตัร ลิขสิทธิ์ เครื่องหมายการคา
หรือสิทธิ์อื่นใดของบุคคลที่สาม 
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Nokia และ Nokia Connecting People, Nseries และ N73 เปนเครื่องหมายการคาจดทะเบียนของ Nokia Corporation 
ชื่อผลติภัณฑอื่นหรือชื่อบริษทัอื่นที่กลาวถึงในที่นี่อาจเปนเครื่องหมายการคาหรือเครื่องหมายการคาของผูเปนเจาของ
อื่นๆ ตามลําดบั

โนเกียดําเนนินโยบายในการพัฒนาอยางตอเนื่อง ดงันัน้ เราจึงขอสงวนสิทธิท์ี่จะเปลี่ยนแปลงและปรับปรุงสวนหนึ่งสวนใด
ของผลิตภัณฑที่อธิบายไวในเอกสารฉบบันี้โดยไมตองแจงใหทราบลวงหนา

ตามขอบขายสูงสดุที่อนุญาตโดยกฎหมายที่นํามาใช ไมวาจะอยูภายใตสถานการณใด NOKIA หรือผูใหอนุญาตรายใด
ของ NOKIA จะไมรับผิดชอบตอการสญูหายของขอมูลหรือรายได หรือความเสียหายพิเศษ โดยอุบัตกิารณ 
อันเปนผลสบืเนื่องหรือความเสียหายทางออมไมวาจะดวยสาเหตใุด

เนื้อหาในเอกสารนี้ใหขอมูล "ตามสภาพที่เปน" โดยไมมีการรับประกันใดๆ ไมวาจะโดยตรงหรือโดยนัย 
และมิไดจํากัดอยูทีก่ารรับประกันความสามารถในการทํางานของผลติภัณฑที่จําหนาย หรือความเหมาะสม
ในการใชงานตามวตัถุประสงค ตลอดจนความถูกตอง ความเชื่อถือไดหรือขอมูลในเอกสารนี้ 
นอกเหนือจากขอบเขตที่กฎหมายระบไุวเทานั้น โนเกียขอสงวนสิทธิ์ในการเปลีย่นแปลงแกไขหรือเพิกถอน
เอกสารนี้โดยไมตองแจงใหทราบลวงหนา

ผลติภัณฑและโปรแกรมเฉพาะทีว่างจําหนายอาจแตกตางกันไปตามภูมิภาค 
โปรดตรวจสอบรายละเอียดและตัวเลอืกภาษาทีม่ีใหเลอืกใชไดจากตัวแทนจําหนาย Nokia

การทํางานและคณุสมบตัิบางอยางจะขึ้นอยูกับซิมการด และ/หรือเครือขาย MMS 
หรือความสามารถในการใชงานรวมกันไดของอุปกรณและรูปแบบเนื้อหาที่ไดรับการสนับสนุน 

บริการบางประเภทจะเรียกเก็บคาบริการเพิ่มเตมิ
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บทนํา
หมายเลขรุน: Nokia N73-1 Music Edition

ในที่นี้จะเรียกวา Nokia N73

โทรศัพท Nokia N73 คือ โทรศัพทมัลติมีเดียอัจฉริยะและทรงพลัง มีแอปพลิเคชั่น

ที่หลากหลายที่จัดเตรียมไวโดย Nokia และบริษัทพัฒนาซอฟตแวรอื่นๆเพื่อชวยใหคุณ

ใช Nokia N73 ไดอยางคุมคามากยิ่งขึ้น

บางแอปพลิเคชั่นรวมอยูในหนวยความจําของอุปกรณ และบางแอปพลิเคชั่นอยูใน

แผนซีดีรอมที่มาพรอมกับโทรศัพท

การใหบริการแอปพลิเคชั่นนี้อาจจะแตกตางกันตามประเทศหรือพื้นที่จัดจําหนาย

ของคุณ และแอปพลิเคชั่นนี้อาจจะใชไดเฉพาะในบางภาษาเทานั้น

ในการใชแอปพลิเคชั่น คุณตองยอมรับเงื่อนไขของใบอนุญาตที่นํามาใช

สัญลักษณตางๆ ในเอกสารชุดนี้แสดงใหทราบวามีแอปพลิเคชั่นที่พรอมนํามาใช

อยูในหนวยความจําของอุปกรณ ( ) การดหนวยความจํา miniSD ( ) 

หรือบนแผนซีดีรอม ( )

โปรดดูขอมูลที่สําคัญอืน่ๆ เกี่ยวกับโทรศัพทไดจากคูมือผูใช

คุณตองติดตั้งแอปพลิเคชั่นจากแผนซีดีรอมลงในเครื่องคอมพิวเตอรที่ใชงาน

รวมกันไดกอนที่จะใชแอปพลิเคชันเหลานั้น

บริการเสริมจากระบบเครือขาย
คุณตองสมัครใชบริการจากผูใหบริการระบบไรสายเพื่อใชงานโทรศัพท 

คุณสมบัติหลายๆ คุณสมบัติตองใชรวมกับคุณสมบัติเครือขายพิเศษ 

คุณสมบัติเหลานี้ไมทํางานบนทุกเครือขาย เครือขายตางๆ อาจตองการ

ใหคุณทําขอตกลงเฉพาะกับผูใหบริการกอนจึงจะสามารถใชบริการเสริมจาก

ระบบเครือขายได ผูใหบริการสามารถใหคําแนะนําและอธิบายถึงคาบริการ

ที่เรียกเก็บ ในบางเครือขาย อาจมีขอจํากัดที่สงผลกระทบตอการใชงานบริการเสริม

ของระบบเครือขาย ตัวอยางเชน ในบางเครือขายอาจจะไมรองรับตัวอักษร

ของทุกภาษาและการบริการทั้งหมด

การสนับสนุน 
แอปพลิเคชั่นของบริษัทพัฒนาซอฟตแวรภายนอกไดรับการสนับสนุนจาก

บริษัทพัฒนาเหลานั้น หากคุณประสบปญหาเกี่ยวกับแอปพลิเคชั่น โปรดดูขอมูล

การสนับสนุนไดจากเว็บไซตที่เกี่ยวของ โปรดดูเว็บลิงคที่ตอนทายของแตละ

แอปพลิเคชั่นในคูมือเลมนี้



2

  

  

รศัพทไวใกลหูระหวาง

อกลําโพง เนื่องจากเสียงจะดังมาก

การใช Push to talk เพื่อรับสายโทรศัพท

sh to talk

เชื่อมตออินเตอรเน็ต (IAP) เปนจุดเชื่อมตอ

าจจะใหคุณใชจุดเชื่อมตอ WAP ได 

ับขอมูลเพิ่มเติม

อาจตองติดตอผูใหบริการโทรศัพทของคุณ

เชื่อมตอเปนครั้งแรก หรือเยี่ยมชมเว็บไซต 

ngs

ารสนทนา > ตัวเลือก > การตั้งคา

ูลดังตอไปนี้:

ง ถาคุณตองการดูการแจงเตือนของสายเรียกเขา 

งการใหรับสายโทรสนทนาอัตโนมัติ เลือก 

สธสายสนทนาโดยอตัโนมัติ

 ตั้งตามรูปแบบ ถาคุณตองการใหการตั้งคาการ

มือนกับแบบเสียงเตือนสายเรียกเขาที่ระ
กา
รเ
ช ือ

ม
ต อ
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การเชือ่มตอ

การสนทนา 

การสนทนา (PTT) (บริการเสริมจากระบบเครือขาย) คือ การสนทนาตามเวลาจริง

ผานบริการ IP ที่ใชผานขอมูลแพคเก็ต การสนทนาคือการสนทนาโดยใชเสียงโดยตรง

ที่เชื่อมตอเขากับปุมสนทนา ใชการสนทนาเพื่อสนทนากับคนๆ หนึ่งหรือกลุมคน

กลุมหนึ่ง 

คุณตองกําหนดจุดเชื่อมตอและการตั้งคาของ Push to talk กอน จึงจะสามารถใช

ฟงกชัน Push to talk ได คุณจะไดรับการตั้งคาเปนขอความตัวอกัษรแบบพิเศษ

จากผูใหบริการที่นําเสนอบริการ Push to talk นั้น คุณยังสามารถใชแอปพลิเคชั่น 

ตัวชวยตั้งคา 

เพื่อกําหนดคาหากไดรับการสนับสนุนจากผูใหบริการเครือขายของคุณ โปรดดูที่ 

”ตัวชวยตั้งคา” หนา 9

กด  และเลือก เครื่องมือ > การสนทนา

ในการสนทนา คนคนหนึ่งจะพูดขณะที่คนอีกกลุมหนึ่งจะรับฟงผานลําโพง

ที่อยูภายในเครื่อง ผูพูดจะตองหมุนเวียนการพูดใหกับบุคคลอื่น เนื่องจากสมาชิก

ในกลุมจะสามารถพูดไดเพียงครั้งละหนึ่งรายเทานั้น และระยะเวลาสูงสุดของ

รอบเวลาโตตอบกลับจะมีจํากัด ซึ่งระยะเวลาสูงสุดที่กําหนดไวคือ 30 วินาที 

โปรดติดตอผูใหบริการระบบหรือผูใหบริการ เพื่อขอรายละเอียดเพิ่มเติม

เกี่ยวกับระยะเวลาของรอบเวลาพูดกลับในระบบเครือขายของคุณ

คําเตือน: โปรดอยาถือโท

การใชฟงกชันเปดเสียงอ

หากมีสายโทรเขา เครื่องจะออกจาก

กําหนดจุดเชือ่มตอ Pu

ผูใหบริการสวนใหญจะใหคุณใชจุด

ที่ระบบตั้งให ผูใหบริการรายอื่นๆ อ

โปรดติดตอผูใหบริการของคุณสําหร

หากคุณไมมีการเชื่อมตอ WAP คุณ

เพื่อขอรับความชวยเหลือเมื่อทําการ

www.nokia-asia.com/phonesetti

การตัง้คาสนทนา

กด  และเลือก เครื่องมือ > ก

เลือก การตั้งคาผูใช และปอนขอม

การโทรสนทนาขาเขา—เลือก แจ

เลือก ยอมรับอัตโนมัติ หากคุณตอ

ไมอนุฆาต หากคุณตองการใหปฏิเ

แบบเสียงแจงโทรสนทนา—เลือก

เตือนสายเรียกเขา Push to Talk เห

บุไวในรูปแบบที่ใชอยู

http://www.nokia-asia.com/phonesettings
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สนทนา การสนทนาจะล็อกอินเขาสูบริการ

เชื่อมตอโดยอตัโนมัติเขาสูชองสัญญาณ

กเชื่อมตอไมสําเร็จ เครื่องจะพยายาม

นกวาคุณเลือกที่จะออกจากการสนทนา

สนทนา > ตัวเลอืก > ออก, 

ลิเคชั่น? จะปรากฏ เลือก ใช 

 ไม หากคุณตองการใหแอปพลิเคชั่นยังคง

ลิเคชั่นเปดอยู และคุณตองการสลับจาก

นึ่ง ใหกด  คางไว

กรายการ แลวเลือก ตัวเลือก > คุย 1 ตอ 1 

ังสนทนา เมื่อคุณพูดจบ ใหปลอยปุม 

งการโดยการกด  คางไวในหนาจออื่น

อยางเชน ในหนาจอรายชื่อ ในการโทรออก

ตอหนึ่งกอน เลือก เลิกเชื่อมตอ หรือกด 

ไวหนาตัวคุณเสมอระหวางโทร

ภาพ คุยผานไมโครโฟน 
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

แบบเสียงคําขอโทรกลับ—เลือกเสียงสําหรับคําขอใหติดตอกลับ

การเริ่มแอปพลิเคชั่น—เลือกหากคุณตองการล็อกอนิเขาสูบริการสนทนา

เมื่อเปดเครื่อง

ชื่อเลนที่ตั้งไว—ใสชื่อเลนที่ตั้งไวของคุณ ซึ่งจะปรากฏใหผูใชรายอื่นไดเห็น 

ผูใหบริการของคุณอาจปดการใชงานตัวเลือกนี้ในเครื่องของคุณ

แสดงที่อยูสนทนาของฉัน—เลือก ในการโทร 1 ตอ 1, ในการโทรแบบกลุม, 

ในการโทรทั้งหมด หรือ ไมเลย ผูใหบริการของคุณอาจปดการใชงาน

บางตัวเลือกนี้ในเครื่องของคุณ

แสดงสถานะล็อกอิน—เลือก ใช ถาคุณตองการแสดงสถานะของคุณ หรือ ไม 

ถาคุณตองการซอนสถานะของคุณ

เลือก การตัง้คาการเชื่อมตอ และปอนขอมูลดังตอไปนี้:

โดเมน—ปอนชื่อโดเมนที่ไดรับจากผูใหบริการ

ชื่อจุดเชื่อมตอ—ปอนชื่อจุดเชื่อมตอ Push to talk จําเปนตองมีชื่อจุดเชื่อมตอ

เพื่อสรางการเชื่อมตอไปยังเครือขาย GSM/GPRS 

ที่อยูเซิรฟเวอร—ปอนที่อยู IP หรือชื่อโดเมนของเซิรฟเวอร Push to talk 

ที่ไดรับจากผูใหบริการ

ชื่อผูใช—ปอนชื่อผูใชที่ไดรับจากผูใหบริการ

รหัสผาน—ปอนรหัสผานเพื่อเชื่อมตอขอมูล หากจําเปน คุณมักจะไดรับรหัสผาน

จากผูใหบริการของคุณ และมักตองคํานึงถึงตัวพิมพ

การล็อกเขาสูการสนทน

กด  และเลือก เครื่องมือ > การ

โดยอตัโนมัติเมื่อเริ่มตน

เมื่อล็อกอินสําเร็จแลว การสนทนาจะ

ที่ใชอยูเมื่อปดแอปพลิเคชั่นลาสุด หา

ล็อกอินกลับเขาไปใหมโดยอัตโนมัติ จ

การออกจากการสนทนา

กด  และเลือก เครื่องมือ > การ

ปดการสนทนาหลังออกจากแอปพ

เพื่อล็อกเอาตและปดการบริการ เลือก

ทํางานเปนพื้นหลัง หากมีหลายแอปพ

แอปพลิเคชั่นหนึ่งไปอีกแอปพลิเคชั่นห

การโทรแบบหนึ่งตอหนึ่ง

เลือก ตัวเลือก > รายชื่อสนทนา

เลือกผูติดตอที่คุณตองการคุยดวยจา

กด  คางไวตลอดเวลาที่คุณกําล

คุณยังสามารถสนทนากับรายชื่อที่ตอ

ที่อยูในแอปพลิเคชั่น การสนทนา ตัว

สายใหม ใหวางสายการโทรแบบหนึ่ง

เคล็ดลับ! คุณควรวางเครื่อง

สนทนาเพื่อที่คุณจะไดเห็นจอ

และอยาใชมือปดลําโพง
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   าธารณะที่ถูกกําหนดการตั้งคาไวลวงหนาแลว 

ับทุกคนที่รูจัก URL ของชองสัญญาณ 

และพูดคุยแลว สมาชิกทั้งหมดที่เขารวมใน

ชองสัญญาณสามารถทํางานไดสูงสุดหาชอง

ชองสัญญาณที่ใชงานอยู ใช สลับ เพื่อเปลี่ยน

าสาธารณะที่กําหนดคาไวลวงหนาเปนครั้งแรก 

ิ่มที่มีอยู เมื่อคุณเขารวมชองสนทนาที่กําหนด

ําหรับชองสนทนา

ุณเอง

ําหนดคาไวลวงหนาใหม ใหเลือก ตัวเลือก > 

ารณะของคุณเองได โดยเลือกชื่อชองสัญญาณ

ิกเหลานั้นสามารถเชิญสมาชิกรายอื่นๆ 

ะ 

สวนตัวได เฉพาะผูใชที่ไดรับเชิญจากเจาภาพ

และใชชองสัญญาณสวนตัว

ุสิ่งตอไปนี้: ชื่อชอง, ความปลอดภัยของชอง, 

อง (ถามี) 

ว คุณจะถูกถามวาตองการสงคําเชิญ

ญาณจะอยูในรูปขอความแบบอกัษร
กา
รเ
ช ือ

ม
ต อ

ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

การรับสายแบบหนึ่งตอหนึ่ง

กด  เพื่อเริ่มการโทรแบบหนึ่งตอหนึ่ง หรือ  เพื่อไมรับสาย

เคล็ดลับ! คุณสามารถสรางการโทรแบบหนึ่งตอหนึ่งหรือการ

โทรแบบกลุมไดจากรายชื่อ เลือก ตัวเลือก > ตัวเลือกสนทนา > 

สรางการโทร 1 ตอ 1 หรือ สรางการโทรกลุม

การสรางการโทรแบบกลุม

หากตองการโทรไปยังกลุม ใหเลือก ตวัเลือก > รายชื่อสนทนา 

เลือกรายชื่อที่คุณตองการโทร และเลือก ตัวเลือก > สรางโทรสนทนาแบบกลุม

การสมัครรับสถานะล็อกอินของผูอื่น

หากตองการสมัครสมาชิกหรือยกเลิกการสมัครสมาชิกขอสถานะการล็อกอนิของ

ผูอื่น เลือก ตัวเลือก > รายชื่อสนทนา รายชื่อ และ ตัวเลือก > 

แสดงสถานะล็อกอิน หรือ ซอนสถานะล็อกอิน

การสงคําขอโทรกลับ

ใน รายชื่อสนทนา เลื่อนไปที่ชื่อที่ตองการ แลวเลือก ตัวเลือก > สงคําขอโทรกลับ

การตอบกลับคําขอโทรกลับ

เมื่อมีบุคคลสงคําขอโทรกลับมาที่คุณ 1 คําขอใหมใหโทรกลับ 

จะปรากฏขึ้นในโหมดสแตนดบาย เลือก แสดง เพื่อเปด ถาดเขาโทรกลับ 

เลือกรายชื่อ และ ตัวเลือก > คยุ 1 ตอ 1 เพื่อเริ่มการโทรแบบหนึ่งตอหนึ่ง 

ชองสัญญาณ

คุณสามารถเขารวมชองสัญญาณส

ชองสัญญาณสาธารณะจะเปดใหก

เมื่อคุณเชื่อมตอเขากับชองสัญญาณ

ชองสัญญาณจะไดยินสิ่งที่คุณพูด 

ในเวลาเดียวกัน เมื่อมีมากกวาหนึ่ง

ชองสัญญาณที่คุณตองการคุย 

เลือก ตัวเลือก > ชองสนทนา

หากตองการเชื่อมตอกับชองสนทน

ใหเลือก ตัวเลือก > ชองใหม > เพ

คาไวลวงหนา คุณตองพิมพ URL ส

การสรางชองสัญญาณของค

หากตองการสรางชองสัญญาณที่ก

ชองใหม > สรางใหม 

คุณสามารถสรางชองสัญญาณสาธ

ของคุณเอง และเชิญสมาชิก สมาช

ใหเขารวมในชองสัญญาณสาธารณ

คุณยังสามารถตั้งคาชองสัญญาณ

เทานั้นที่จะไดรับอนุญาตใหเขารวม

สําหรับแตละชองสัญญาณ ใหระบ

ชื่อเลนในชอง และ ภาพยอของช

เมื่อคุณสรางชองสัญญาณสําเร็จแล

ชองสัญญาณหรือไม คําเชิญชองสัญ
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ชองสัญญาณ

ลือก ตัวเลือก > จัดเก็บชองสนทนา 

นทนาของคุณในหนาจอชองสัญญาณ

าณแลว คุณจะถูกถามวาตองการ

ือก ใช เพื่อเปดหนาจอเซสชัน Push to Talk 

ารหากคุณยังไมไดล็อกอิน

นั้นจะถูกจัดเก็บไวในถาดเขาที่ใชรับสง

ัญญาณในภายหลัง ใหเปดขอความเชิญและ

ตอบเพื่อเชื่อมตอกับชองสัญญาณ

 talk

สนทนา > ตัวเลอืก > บันทึกสนทนา 

นี้: เบอรไมไดรับ, สายที่ไดรับ และ 

ก บันทึกสนทนา ใหกด 
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

การคุยที่ชองสัญญาณ

ในการคุยกับชองสัญญาณหลังจากที่คุณไดล็อกอินเขาสูบริการ Push to Talk แลว 

ใหกด  คุณจะไดยินแบบเสียงที่บงชี้วาอนุญาตใหเขาใชงานได

สนทนาตอไดดวยการกด  คางไวตลอดเวลาที่คุณกําลังสนทนา 

เมื่อคุณสนทนาเสร็จแลว ใหปลอย  

หากคุณพยายามตอบกลับชองสัญญาณดวยการกด  ขณะที่สมาชิก

อีกคนหนึ่งกําลังคุยอยู ขอความ รอ จะปรากฏขึ้น ปลอย  รอใหอกีฝายหนึ่ง

พูดจบ และกด  อีกครั้งเมื่อผูพูดพูดจบ หรือกด  คางไว และรอใหขอความ 

คุย ปรากฏขึ้น

เมื่อคุณกําลังคุยอยูในชองสัญญาณ คนแรกใหกด  เมื่ออีกคนหนึ่งที่หยุดพูด

จะพูดถัดไป

เมื่อคุณจบการโทรสนทนา ใหเลือก เลิกเชื่อมตอ หรือกด  

ในการดูสมาชิกที่ใชงานอยูในชองสัญญาณในขณะนี้เมื่อคุณมีสายที่ใชอยูใน

ชองสัญญาณ ใหเลือก ตัวเลือก > สมาชิกที่ใชงาน

ในการเชิญสมาชิกใหมใหเขารวมในชองสัญญาณเมื่อคุณเชื่อมตอเขากับ

ชองสัญญาณได ใหเลือก ตัวเลือก > สงคําเชิญ เพื่อเปดดูหนาจอการเชิญ 

คุณสามารถเชิญสมาชิกใหมไดเมื่อคุณเปนเจาภาพของชองสัญญาณสวนตัวเทานั้น 

หรือเมื่อชองสัญญาณนั้นเปนชองสัญญาณสาธารณะ คําเชิญชองสัญญาณจะอยู

ในรูปขอความตัวอักษร

การตอบกลบัคําเชิญของ

ในการบันทึกคําเชิญของชองที่ไดรับ เ

ชองสัญญาณจะถูกเพิ่มลงในรายชื่อส

หลังจากที่คุณจัดเก็บคําเชิญชองสัญญ

เชื่อมตอไปยังชองสัญญาณหรือไม เล

เครื่องของคุณจะล็อกอินเขาสูการบริก

หากคุณปฏิเสธหรือลางคําเชิญ คําเชิญ

ขอความของคุณ ในการเขารวมชองส

จัดเก็บคําเชิญ เลือก ใช จากกลองโต

การดูไฟลบันทกึ Push to

กด  และเลือก เครื่องมือ > การ

บันทึกจะประกอบดวยโฟลเดอรตอไป

เบอรที่สราง

ในการเริ่มการโทรแบบหนึ่งตอหนึ่งจา
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ดาวนโหลด 

ดวย ดาวนโหลด (บริการเสริมจากระบบเครือขาย) คุณสามารถพบภาพแสดง

ตัวอยาง ซื้อ ดาวนโหลด และปรับปรุงเนื้อหา บริการ และแอปพลิเคชั่นที่ทํางาน

รวมกับ Nokia N73 เกมส เสียงเรียกเขา ภาพพื้นหลัง แอปพลิเคชั่น และอื่นๆ 

อีกมากมายพรอมใหดาวนโหลด รายการจะถูกจําแนกประเภทตามแค็ตตาล็อก

และแฟมขอมูลซึ่งผูใหบริการแตละรายจัดเตรียมไวให โดยเนื้อหาที่มีอยูจะขึ้นอยูกับ

ผูใหบริการ

กด  และเลือก อินเทอรเน็ต > ดาวนโหลด

ดาวนโหลด ใชบริการเครือขายของคุณเพื่อเขาสูเนื้อหาที่ทันสมัยที่สุด 

โปรดติดตอผูใหบริการเครือขายของคุณ หรือผูจัดจําหนายหรือผูผลิตของรายการ 

เพื่อขอรับขอมูลเกี่ยวกับรายการเพิ่มเติมผานทาง ดาวนโหลด

ดาวนโหลด รับขอมูลที่ทันตอเหตุการณอยางตอเนื่องและจัดเตรียมเนื้อหาลาสุด 

ที่ผูใหบริการเครือขายหรือผูใหบริการสามารถจัดหาใหไดสําหรับอุปกรณของคุณ 

หากตองการอัพเดตเนื้อหาใน ดาวนโหลด ดวยตนเอง เลือก ตัวเลือก > 

รีเฟรชรายการ

หากตองการทําการซอนโฟลเดอรหรือแค็ตตาล็อกจากรายการ ยกตัวอยางเชน 

เพื่อที่จะดูแครายการที่คุณใชบอย ใหเลือก ตัวเลือก > ซอน 

หากตองการทํารายการที่ซอนอยูทั้งหมดใหปรากฏอีกครั้ง ใหเลือก ตัวเลือก > 

แสดงทั้งหมด

หากตองการจะซื้อรายการที่ไดเลือกในการดูหลัก หรือในโฟลเดอร หรือแค็ตตาล็อก 

ใหเลือก ตัวเลือก > ซื้อ เมื่อเมนูยอยเปดขึ้น คุณสามารถเลือกเวอรชั่นของรายการ

และดูขอมูลราคาจากเมนูยอยนั้นได โดยตัวเลือกที่มีจะขึ้นอยูกับผูใหบริการ

หากตองการดาวนโหลดรายการที่ไมตองเสียคาใชจาย ใหเลือก ตวัเลือก > รับ

การตั้งคาสําหรบัดาวนโหลด
แอปพลิเคชั่นจะปรับปรุงโทรศัพทของคุณดวยเนื้อหาลาสุดที่มีอยูจากผูใหบริการ

เครือขายหรือผูใหบริการของคุณและชองสัญญาณที่มีอยูอื่นๆ 

หากตองการเปลี่ยนแปลงการตั้งคา เลือก ตัวเลือก > การตัง้คา >

จุดเชื่อมตอ—เลือกจุดเชื่อมตอที่ใชในการเชื่อมตอกับเซิรฟเวอรของผูใหบริการ 

และเลือกวาจะใหโทรศัพทสอบถามถึงจุดเชื่อมตอทุกครั้งที่คุณใชหรือไม

เปดอัตโนมตัิ—เลือก ใช หากคุณตองการใหเนื้อหาหรือแอปพลิเคชั่นเปดขึ้นมาโดย

อัตโนมัติหลังจากดาวนโหลดแลว

ยืนยันการดูตัวอยาง—เลือก ไม หากคุณตองการดาวนโหลดภาพตัวอยาง

ของเนื้อหาหรือแอปพลิเคชั่นโดยอตัโนมัติ เลือก ใช หากคุณตองการใหเครื่องถาม

ทุกครั้งกอนดาวนโหลดภาพตัวอยาง

ยืนยันการซื้อ—เลือก ใช หากคุณตองการใหเครื่องขอรับคํายืนยันกอนซื้อเนื้อหา

หรือแอปพลิเคชั่น หากคุณเลือก ไม ขั้นตอนการซื้อจะเริ่มตนทันทีหลังจากที่คุณ

เลือกตัวเลือก ซื้อ

หลังจากที่คุณตั้งคาเสร็จแลว ใหเลือก กลับ 
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าต และเสร็จสิ้นการติดตั้ง

bile Security

bile Security เพื่อใชงานแอปพลิเคชั่น 

อบ เลือก ตวัเลือก > Change 

valuation และกด Done

รอพัเดตและทําการดาวนโหลดอัพเดต

ทะเบียบเรียบรอยแลว เลือก OK 

บบ 30 วัน ชวงทดลองใชจะเริ่มนับ

ecurity หลังจากชวงทดลองใช

ตคุณจะไมสามารถดาวนโหลดซอฟตแวร

สี่ยงดานความปลอดภัย หากตองการ

ังจากชวงทดลองใช คุณตองซื้อเวลา
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

แอปพลิเคชั่น

F-Secure Mobile Security 

ซอฟตแวร F-Secure Mobile Security สําหรับโทรศัพทเคลื่อนที่ใหการปกปองเนื้อหา

ที่เปนอันตรายบนโทรศัพทแบบเรียลไทม พรอมขอมูลอพัเดตโปรแกรมปองกันไวรัส

อัตโนมัติ F-Secure Mobile Security ออกแบบมาใหสแกนทุกไฟลที่คุณเปดบน

โทรศัพทโดยอัตโนมัติเพื่อคนหาไวรัส และแยกไฟลที่ติดไวรัสออกจากไฟลอื่น

เพื่อปกปองไฟลที่เหลือ F-Secure Mobile Security ยังมีไฟรวอลลที่ใหการปกปอง

โทรศัพทจากการบุกรุก

การตดิตัง้ F-Secure Mobile Security

ขอสําคัญ: โทรศัพทของคุณสนับสนุนแอปพลิเคชั่นปองกัน

ไวรัสเพียงหนึ่งแอปพลิเคชั่น การมีแอปพลิเคชั่นปองกันไวรัส

มากกวาหนึ่งแอปพลิเคชั่นอาจมีผลตอสมรรถนะและ

การทํางานของโทรศัพท หรือทําใหโทรศัพทไมทํางาน

กด  และเลือก เครื่องมือ > Mobile Security เพื่อใชงานตัวดาวนโหลด

แอปพลิเคชั่น F-Secure Mobile Security (บริการเสริมจากระบบเครือขาย) 

เครื่องจะดาวนโหลดชุดติดตั้งจากที่อยูเว็บที่ระบุไวลวงหนา และติดตั้งแอปพลิเคชั่น 

จากนั้น ดําเนินการดังตอไปนี้

1 เลือก Yes เพื่อเชื่อมตอกับบริการดาวนโหลดและดาวนโหลดชุดติดตั้ง เลือก OK 

เพื่อดําเนินการตอ

2 เลือก Yes เพื่อติดตั้งแอปพลิเคชั่น และ Done

3 เลือก OK ถาคุณยอมรับใบอนุญ

4 เลือก ปด เพื่อออกจากตัวติดตั้ง

การใชงาน F-Secure Mo

กด  และเลือก เครื่องมือ > Mo

และดําเนินการดังตอไปนี้

1 ในหนาจอตอนรับ กด OK

2 หากตองการเริ่มตนชวงการทดส

เลือกประเภทการใชงาน Free e

3 เลือก Yes เพื่อเชื่อมตอกับบริกา

4 คุณจะไดรับขอความยืนยันวาลง

เพื่อดําเนินการตอ

5 เลือก OK เพื่อยุติการใชงาน

แอปพลิเคชั่นนี้เปนเวอรชันทดลองใชแ

ตั้งแตคุณใชงาน F-Secure Mobile S

คุณจะยังสามารถใชแอปพลิเคชั่นไดแ

ที่อัพเดตแลวได ซึ่งจะทําใหเกิดความเ

ดาวนโหลดซอฟตแวรที่อพัเดตแลวหล

การบริการเพิ่ม
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นหนาจอ และควบคุมการเครือขาย

ษาความปลอดภัยที่ระบุไวลวงหนาที่คุณเลือก 

จะแสดงระดับการปองกันของไฟรวอลล

ไฟรวอลล เลือก ตัวเลือก > Settings > Firewall 

ี้:

สงออกทั้งหมดโดยไมมีการปองกันการบุกรุก

ด

ลิเคชั่นในโทรศัพทที่ใชบอย

งออกทั้งหมด คุณไมสามารถใชบริการใดๆ 

อีเมล หรือการเรียกดูเว็บ

cure Mobile Security โปรดดูที่

f-secure.com/products/fsms.html
แอ
ป
พ
ล ิเ
คช

 ัน
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การสแกนโทรศพัท

คุณสามารถสแกนหาไวรัสในโทรศัพทไดดวยตนเอง หรือใช F-Secure Mobile 

Security สแกนใหโดยอตัโนมัติ ในการเลือกวาจะสแกนไฟลดวยตนเองหรืออัตโนมัติ 

ใหเลือก ตัวเลือก > Settings > Mode > Real-time หรือ Manual ถาคุณเลือก

Real-time F-Secure Mobile Security จะทํางานโดยไมปรากฏบนหนาจอ

ขณะที่คุณใชโทรศัพท และจะสแกนไฟลโดยอัตโนมัติเมื่อไฟลถูกใชงาน

หากตองการสแกนไฟลในโทรศัพทดวยตนเอง ในหนาจอหลัก F-Secure Mobile 

Security เลือก ตัวเลือก > Scan all

หากตองการแยกไฟลที่ติดไวรัสออกจากไฟลอื่นๆ หรือลบทิ้งหลังการสแกน 

ใหเลื่อนไปที่แถบ Infection เลือกไฟล และ ตัวเลือก > Process selected จากเมนู   

Select action เลือก Quarantine หรือ Delete

หากตองการใหฐานขอมูลไวรัสของคุณทันสมัย คุณสามารถอัพเดตซอฟตแวร

ปองกันไวรัสในโทรศัพทของคุณได ในการดึงตัวอพัเดตปองกันไวรัส คุณจําเปนตอง

มีจุดเชื่อมตออินเทอรเน็ตที่กําหนดไวในโทรศัพทของคุณ สําหรับขอมูลเพิ่มเติม

เกี่ยวกับจุดเชื่อมตอ สามารถดูไดจากคูมือผูใชโทรศัพทของคุณ คุณจะไดรับการแจง

และสามารถดาวนโหลดตัวอัพเดตไดจากเซิรฟเวอร เมื่อมีซอฟตแวรปองกันไวรัสที่

อัพเดตแลวใหดาวนโหลดบนเซิรฟเวอร หากตองการอัพเดต F-Secure Mobile

 Security ดวยตนเอง เลือก ตัวเลือก > Update

ไฟรวอลล

ไฟรวอลลจะทํางานโดยไมปรากฏบ

รับเขาและสงออก ตามระดับการรัก

Firewall protection ในหนาจอหลัก

ในการเปลี่ยนระดับการปองกันของ

protection และจากตัวเลือกตอไปน

Allow all—อนุญาตการรับเขาและ

Normal—อนุญาตการสงออกทั้งหม

High—อนุญาตการรับสงจากแอปพ

Deny all—ปฏิเสธการรับเขาและส

ที่ตองการการใชงานเครือขาย เชน 

สําหรับขอมูลเพิ่มเติมเกี่ยวกับ F-Se

 mobile.f-secure.com หรือ www.

http://mobile.f-secure.com
http://www.f-secure.com/products/fsms.html
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งการตั้งคาเมลบอกซสําหรับ

ตั้งคาการสนทนา (การสนทนา) 

) ตัวชวยตั้งคา จะตรวจหาผูใหบริการ

คํายืนยันจากคุณ เลือก ตกลง หรือเลื่อนไปที่

กลง

องระบุชื่อผูใช รหัสผาน และชื่อเลน 

ะเลือก ตัวเลือก > เปลี่ยน ปอนรายละเอียด 

ปอนขอมูลเสร็จ

งตั้งคา การสนทนา 

ตั้งคา มุมมองรวม (บริการเสริมจากระบบ

จหาผูใหบริการเครือขายที่พรอมนํามาใชและ

ง หรือเลื่อนไปที่ผูใหบริการระบบอื่น และเลือก 
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

เครื่องมือ

ตัวชวยตัง้คา 
ตัวชวยตั้งคา ทําหนาที่กําหนดคาโทรศัพทของคุณสําหรับการใชงาน (MMS, GPRS 

และอินเทอรเน็ตเคลื่อนที่) อีเมล Push to Talk (บริการเสริมจากระบบเครือขาย) 

และการใชวิดีโอรวมกัน (บริการเสริมจากระบบเครือขาย) โดยอิงกับขอมูลของ

ผูใหบริการเครือขายของคุณ

ในการใชบริการเหลานี้ คุณอาจตองติดตอผูใหบริการเครือขายของคุณหรือ

ผูใหบริการเพื่อเรียกใชการเชื่อมตอขอมูลหรือบริการอื่น

กด  และเลือก เครื่องมือ > ตัวตั้งคา

เลือกรายการจากเมนูที่คุณตองการกําหนดคาอุปกรณของคุณ และกด 

อีเมล

1 เมื่อคุณเลือกที่จะกําหนดคาการตั้งคาอีเมล ตัวชวยตั้งคา จะตรวจหาผูใหบริการ

เครือขายที่พรอมนํามาใชและขอคํายืนยันจากคุณ เลือก ตกลง หรือเลื่อนไปที่

ผูใหบริการระบบอื่น และเลือกตกลง

2 เลือกผูใหบริการอีเมลของคุณจากรายการ

3 เลือกเซิรฟเวอรจดหมายออก ใชเซิรฟเวอรที่ระบบตั้งไวหากคุณไมแนใจ

4 ตัวชวยตั้งคา จะขอใหคุณปอนรายละเอยีดของอเีมลแอดเดรส ชื่อผูใช 

และรหัสผาน เลือกแตละรายการตามลําดับ และเลือก ตัวเลือก > เปลี่ยน 

ปอนรายละเอียด แลวเลือก ตกลง

5 เลือก ตัวเลือก > ตกลง เมื่อคุณปอนขอมูลเสร็จ

6 เลือก ตกลง เพื่อยืนยันวาคุณตอ

ผูใหบริการเฉพาะราย

7 เลือก ตกลง

การสนทนา

1 เมื่อคุณเลือกที่จะกําหนดคาการ

(บริการเสริมจากระบบเครือขาย

เครือขายที่พรอมนํามาใชและขอ

ผูใหบริการระบบอื่น และเลือก ต

2 สําหรับผูใหบริการบางรายอาจต

เลือกแตละรายการตามลําดับ แล

แลวเลือก ตกลง

3 เลือก ตัวเลือก > ตกลง เมื่อคุณ

4 เลือก ตกลง เพื่อยืนยันวาคุณตอ

สําหรับผูใหบริการเฉพาะราย

การแบงปนวดิีโอ 

1 เมื่อคุณเลือกที่จะกําหนดคาการ

เครือขาย) ตัวชวยตั้งคา จะตรว

ขอคํายืนยันจากคุณ เลือก ตกล

ตกลง
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2 ผูใหบริการบางรายอาจตองการแอดเดรสสําหรับการแบงปนวิดีโอ ชื่อผูใช 

และรหัสผาน เลือกแตละรายการตามลําดับ แลวเลือก ตัวเลือก > เปลี่ยน 

ปอนรายละเอียด แลวเลือก ตกลง

3 เลือก ตัวเลือก > ตกลง เมื่อคุณปอนขอมูลเสร็จ

4 เลือก ตกลง เพื่อยืนยันวาคุณตองการตั้งคาการแบงปนวิดีโอสําหรับ

ผูใหบริการเฉพาะราย

5 หลังจากกําหนดการตั้งคาการแบงดูวิดีโอแลว ตัวชวยตั้งคา จะถามคุณวา 

ตองการสรางหรืออัพเดตรายชื่อของคุณเองหรือไม เลือก ใช หรือ ไม

ผูใหบริการ

1 เมื่อคุณเลือกที่จะกําหนดคาการตั้งคาผูใหบริการของคุณ ตัวชวยตั้งคา 

จะตรวจหาผูใหบริการเครือขายที่พรอมนํามาใชและขอคํายืนยันจากคุณ เลือก 

ตกลง หรือเลื่อนไปที่ผูใหบริการระบบอื่น และเลือก ตกลง

2 เลือก ตกลง เพื่อยืนยันวา คุณตองการกําหนดคาอุปกรณของคุณ

สําหรับผูใหบริการเฉพาะราย

ขอมูลเพิ่มเตมิ

หากคุณประสบปญหาขณะใช ตัวชวยตั้งคา โปรดดูที่เว็บไซตการตั้งคาโทรศัพทของ 

Nokia ไดที่ www.nokia-asia.com/phonesettings

http://www.nokia-asia.com/phonesettings
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Mobile Search 

ใช Mobile Search เพื่อเขาสูเครื่องมือคนหา กอนทําการคนหาและเชื่อมตอกับ

บริการในพื้นที่ เว็บไซต ภาพ และเนื้อหาเคลื่อนที่ คุณสามารถใชแอปพลิเคชั่นดังกลาว 

เชน เพื่อคนหารานคาและรานอาหารในพื้นที่กอนโทรติดตอ และใชเทคโนโลยี

การแสดงแผนที่ขั้นสูงเพื่อชวยคุณคนหาสถานที่ตั้งของรานเหลานั้น

การใช Mobile Search

กด  และเลือก การคนหา

เมื่อคุณเปด Mobile Search รายการประเภทตางๆ จะปรากฏขึ้น เลือกประเภทหนึ่ง 

(เชน ภาพ) และพิมพขอความลงในชองคนหา เลือก การคนหา ผลของการคนหา

จะปรากฏบนหนาจอ

ขอมูลเพิ่มเตมิ

สําหรับความชวยเหลือและคําแนะนําเพิ่มเติมเกี่ยวกับแอปพลิเคชั่น เลือก ตัวเลือก > 

วิธีใช

สําหรับขอมูลเพิ่มเติมเกี่ยวกับแอปพลิเคชั่น โปรดคลิกเขามาที่ www.nokia.com/

mobilesearch/

http://www.nokia.com/mobilesearch/
http://www.nokia.com/mobilesearch/


เก
ม
ส 

12 ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

เกมส

Sudoku 

Sudoku เปนเกมสปริศนาตัวเลขที่ชวยฝกเชาวนปญญาของคุณ ไมมีการคํานวณ

ทางคณิตศาสตร คุณเพียงแคใชเหตุผลและตรรกะในการแกปริศนาตัวเลข และคุณ

จะพบวามันเปนเกมสที่สนุกจนคุณวางไมลง

วัตถุประสงคของ Sudoku คือการแกปริศนาโดยการเติมตัวเลขลงในชองวาง 

โดยในแตละคอลัมน แตละแถว และแตละสวนจะใสตัวเลขนั้นๆ ไดเพียงครั้งเดียว 

คุณสามารถเลือกระดับความยากงายได และจํานวนตัวเลขที่คุณตองเติมขึ้นอยูกับ

ขนาดของแตละปริศนา ใชดินสอจดตัวเลขที่เปนไปไดหากคุณยังไมแนใจ 

มีการตรวจคําตอบและบอกใบเพื่อชวยคุณแกปริศนา แตคุณจะถูกบวกเวลา

เพิ่มทุกครั้งที่ใช

หมายเหตุ: ใชแอปพลิเคชั่นนี้ไดเฉพาะในบางภาษาเทานั้น

ขอมูลเพิ่มเตมิ

หากคุณประสบปญหาเมื่อเลน Sudoku คุณสามารถขอรับคําแนะนําได

โดยสงอเีมลมาที่ info@mbounce.com หรือโทร +852 27773398 

สําหรับคําแนะนําทางโทรศัพท

mailto://info@mbounce.com
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ัพทของคุณ กด  และเลือก Applications >  

มพิวเตอร 

อมพิวเตอรที่ใชรวมกันได 

เทา, 128 MB RAM

(หากตองติดตั้งทั้ง Microsoft DirectX และ 

ก 1024x768 และสี 24 บิต

 Windows XP 

พิวเตอร:

โทรศัพท

เวอร Nokia Connectivity Cable 

อมพิวเตอร 

 9.0 ลงบนคอมพิวเตอร โปรแกรม Microsoft 

Nokia Lifeblog สําหรับคอมพิวเตอร
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

สําหรับเครื่องคอมพิวเตอร

Nokia Lifeblog  

Nokia Lifeblog คือการรวมกันของซอฟตแวรสําหรับโทรศัพทเคลื่อนที่และ

คอมพิวเตอรที่เก็บไดอารีมัลติมีเดียของรายการที่คุณรวบรวมไวดวยโทรศัพท Nokia 

Lifeblog จัดระเบียบรูปถาย วิดีโอ เสียง ขอความแบบอักษร ขอความมัลติมีเดีย 

และประกาศของเว็บบล็อกตามลําดับกอนหลังที่คุณสามารถเรียกดู คนหา ใชรวมกัน 

เผยแพร และทําสําเนาขอมูลไวได ทั้ง Nokia Lifeblog สําหรับคอมพิวเตอรและ 

Nokia Lifeblog สําหรับโทรศัพทเคลื่อนที่จะชวยใหคุณสงหรือบล็อกรายการ

เพื่อใหคนอื่นดูได

Nokia Lifeblog สําหรับโทรศัพทเคลื่อนที่จะตรวจสอบรายการมัลติมีเดียของคุณ

โดยอัตโนมัติ ใช Nokia Lifeblog บนอุปกรณเพื่อเรียกดูรายการของคุณ สงรายการ

ไปใหคนอื่น หรือเผยแพรรายการเหลานั้นลงบนเว็บ เชื่อมตออุปกรณไปยังเครื่อง

คอมพิวเตอรที่ใชรวมกันไดโดยการใชสายเคเบิลขอมูล USB หรือการเชื่อมตอ 

Bluetooth เพื่อโอนยายและซิงโครไนซรายการในอปุกรณกับเครื่องคอมพิวเตอรที่

ใชรวมกันได

Nokia Lifeblog สําหรับคอมพิวเตอรชวยใหคุณเรียกดูและคนหารายการที่คุณได

เก็บสะสมดวยอุปกรณไดอยางงายดาย การโอนยายดวยการกดเพียวหนึ่งปุม

โดยใชสายเคเบิลขอมูล USB หรือการเชื่อมตอ Bluetooth จะทําใหรูปถาย วิดีโอ 

ขอความ และขอความมัลติมีเดียที่คุณชื่นชอบถูกโอนกลับมาที่อปุกรณ

เพื่อการเก็บรักษาไวอยางปลอดภัย คุณสามารถสํารองฐานขอมูล Nokia Lifeblog 

โดยการใชฮารดดิสก ซีดี ดีวีดี ไดรฟที่ถอดออกไดหรือไดรฟเครือขายที่ใชรวมกันได 

นอกเหนือจากนี้ คุณสามารถประกาศรายการลงในเว็บบล็อก (บล็อก) ของคุณ

หากตองการเริ่มใช Lifeblog บนโทรศ

Lifeblog > Options > Open

การติดตั้งลงบนเครื่องคอ

กอนติดตั้ง Nokia Lifeblog ลงเครื่องค

คุณตองมีรายการตางๆ ดังตอไปนี้:

• 1 GHz Intel Pentium หรือเทียบ

• เนื้อที่วางบนฮารดดิสก 400 MB 

Nokia PC Suite) 

• ความสามารถในการแสดงกราฟ

• การดแสดงผลขนาด 32 MB

• Microsoft Windows 2000 หรือ

ในการติดตั้ง Nokia Lifeblog ลงคอม

1 ใหใสแผนซีดีรอมที่ใหมาพรอมกับ

2 ติดตั้ง Nokia PC Suite (รวมไดร

สําหรับการเชื่อมตอ USB)

3 ติดตั้ง Nokia Lifeblog สําหรับค

หากยังไมไดติดตั้ง Microsoft DirectX

DirectX 9.0 จะถูกติดตั้งลงพรอมกับ 
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og PC ใหเลือก File > Copy from phone and to 

อกไปยังคอมพิวเตอร รายการในหนาจอ

ถูกคัดลอกไปยังโทรศัพทของคุณ

g ที่ดีที่สุดของคุณ ใหสงรายการเหลานั้นไปยัง

ื่นชม

ริการเว็บบล็อก สรางหนึ่งเว็บบล็อกหรือหลายๆ 

งของประกาศ และเพิ่มบัญชีเว็บบล็อกไปยัง Nokia 

สําหรับ Nokia Lifeblog คือ TypePad จาก 

com

็บบล็อกใน Nokia Lifeblog ไวในสวนของ

รที่ใชงานรวมกันได ใหแกไขบัญชีใน

ศัพท:

 ใหเลือกรายการที่คุณตองการประกาศลงเว็บ

b

ั้งแรก Nokia Lifeblog จะดึงรายการเว็บบล็อก

กจะเปดขึ้น เลือกเว็บบล็อกที่คุณตองการ

สรางเว็บบล็อกใหมแลว และตองการอพัเดต

tions > Refresh blog list 

ําหรับประกาศ คุณยังสามารถเขียนเรื่อง

าของขอความไดยาวขึ้น
สำ
ห
ร ับ
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ร ือ
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อม
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การเชื่อมตอโทรศพัทกับเครือ่งคอมพิวเตอร

การเชื่อมตออุปกรณและคอมพิวเตอรที่ใชรวมกันไดโดยการใชสายเคเบิลขอมูล USB 

ที่มาพรอมกับอปุกรณ:

1 ดูใหแนใจวาคุณไดติดตั้ง Nokia PC Suite แลว

2 เชื่อมตอสายเคเบิลขอมูล USB กับโทรศัพทและคอมพิวเตอร เมื่อคุณเชื่อมตอ

โทรศัพทกับคอมพิวเตอรในครั้งแรกหลังจากที่คุณไดติดตั้ง Nokia PC Suite แลว 

คอมพิวเตอรจะติดตั้งไดรเวอรเฉพาะสําหรับโทรศัพท และอาจจะใชเวลา

สักครูหนึ่ง

3 เริ่มตนแอปพลิเคชั่น Nokia Lifeblog PC

การเชื่อมตอโทรศัพทกับคอมพิวเตอรที่ใชรวมกันไดโดยการใชเทคโนโลยีไรสาย 

Bluetooth:

1 ดูใหแนใจวา คุณไดติดตั้ง Nokia PC Suite ลงคอมพิวเตอรแลว

2 ดูใหแนใจวา คุณไดจับคูอุปกรณกับคอมพิวเตอรผานเทคโนโลยีไรสาย 

Bluetooth เขากับแอปพลิเคชั่น Get Connected ใน Nokia PC Suite แลว 

โปรดดูที่ ”Nokia PC Suite” หนา 15 และคูมือผูใชของโทรศัพท

3 เปดใชการเชื่อมตอ Bluetooth บนโทรศัพทและคอมพิวเตอร สําหรับรายละเอียด 

โปรดดูที่คูมือผูใชสําหรับอุปกรณและเอกสารสําหรับคอมพิวเตอร

การคัดลอกรายการ

เมื่อคุณเชื่อมตอโทรศัพทเขากับคอมพิวเตอรโดยการใชสายขอมูล USB ที่ใชงาน

รวมกันได หรือการเชื่อมตอ Bluetooth แลว คุณจะสามารถคัดลอกรายการของคุณ

ระหวางโทรศัพทกับคอมพิวเตอรได

การคัดลอกรายการใหมหรือรายการที่แกไขแลวจากโทรศัพทไปยังเครื่องคอมพิวเตอร 

และคัดลอกรายการที่เลือกจากคอมพิวเตอรไปยังโทรศัพท:

1 เริ่มตนแอปพลิเคชั่น Nokia Lifeblog บนคอมพิวเตอร

2 ในแอปพลิเคชั่น Nokia Lifebl

Phone 

รายการใหมจากโทรศัพทจะถูกคัดล

To phone ในเครื่องคอมพิวเตอรจะ

การประกาศลงเว็บ

การแบงปนรายการ Nokia Lifeblo

เว็บบล็อกบนอินเทอรเน็ตเพื่อใหผูอ

สิ่งแรกที่ตองคํา คือสรางบัญชีกับบ

เว็บบล็อกเทาที่คุณใชเปนปลายทา

Lifeblog บริการเว็บบล็อกที่แนะนํา

Six Apart ซึ่งอยูที่ www.typepad.

บนโทรศัพทของคุณ ใหเพิ่มบัญชีเว

การตั้งคาเว็บบล็อก บนคอมพิวเตอ

หนาตาง Edit log accounts

การประกาศรายการลงเว็บจากโทร

1 ใน Timeline หรือ Favourites

2 เลือก Options > Post to We

3 หากคุณใชคุณสมบัตินี้เปนคร

จากเซิรฟเวอรของเว็บบล็อก

4 กลองโตตอบประกาศเว็บบล็อ

ใชจากรายการ Post to: ถาคุณ

รายการเว็บบล็อก ใหเลือก Op

5 พิมพชื่อเรื่องและคําบรรยายส

หรือคําอธิบายลงในชองเนื้อห

http://www.typepad.com
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หรอืรายการโปรด

มพิวเตอรของคุณ คุณสามารถเลื่อนดู

ะ Favourites ไดหลายวิธี วิธีที่รวดเร็วที่สุด

าหรือดานหลัง เร็วหรือชา อีกวิธีหนึ่ง 

ชคุณสมบัติ Go to date... หรือใชปุมลูกศร

ว็บบล็อกและความเขากันไดกับ Nokia 

-asia.com/lifeblog หรือกด F1 ในแอปพลิเคชั่น 

kia Lifeblog

ite 

ชั่นตางๆ บนคอมพิวเตอรที่พัฒนาขึ้นเพื่อใชกับ 

ite คุณตองมีคอมพิวเตอรที่ทํางานดวย

 2000 หรือ XP และสามารถใชรวมกับ

อ Bluetooth ได กอนการใช Nokia PC Suite 

ิวเตอรที่ใชงานรวมกันไดกอน 

ีรอมที่ใหมาพรอมกับโทรศัพท

C Suite มีใหเลือกใชในรูปแบบ

ขอมูลเพิ่มเติม และหากตองการดาวนโหลด

รดเยี่ยมชมที่ www.nokia-asia.com/pcsuite
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

6 เมื่อเสร็จแลว เลือก Options > Send

การประกาศรายการลงเว็บจากคอมพิวเตอร:

1 ใน Timeline หรือ Favourites ใหเลือกรายการ (ไดสูงสุด 50 รายการ) 

ที่คุณตองการประกาศลงเว็บ

2 เลือก File > Post to the Web... หนาตาง Post to the web จะเปดออก

3 พิมพชื่อเรื่องและคําบรรยายสําหรับประกาศ คุณยังสามารถเขียนเรื่องหรือ

คําอธิบายลงในชองเนื้อหาของขอความไดยาวขึ้น

4 เลือกเว็บบล็อกที่คุณตองการใชจากรายการ Post to: 

5 เมื่อเสร็จแลว คลิกที่ปุม สง

การนําเขารายการจากแหลงอื่นๆ

นอกจากรูปภาพ .jpeg ของอุปกรณ คุณยังสามารถนําเขารูปภาพ .jpeg คลิปวิดีโอ 

.3gp, .mp4 ไฟลเสียง .arm และไฟลขอความ .txt จากแหลงอืน่ๆ (เชน ซีดี ดีวีดี 

หรือโฟลเดอรในฮารดดิสก) ลงใน Nokia Lifeblog ไดอกีดวย

การนําเขารูปภาพหรือวิดีโอจากคอมพิวเตอรที่ใชรวมกันไดลงใน Nokia Lifeblog 

สําหรับคอมพิวเตอร:

1 ใน Timeline หรือ Favourites เลือก File > Import from PC... หนาตาง Import 

จะเปดออก

2 เรียกดูรายการเพื่อคนหาไฟลรูปภาพหรือวิดีโอ หรือเสียงหรือไฟลขอความ

จากรายการ หรือสํารวจในโฟลเดอรอืน่เพื่อคนหาไฟลที่คุณตองการนําเขา 

ใชรายการ Look in เพื่อเรียกดูไดรฟหรืออุปกรณอื่นๆ

3 เลือกโฟลเดอร ไฟล หรือหลายๆ ไฟล คุณสามารถดูเนื้อหาของรายการเหลานั้น

ในหนาตาง Preview:  

4 คลิก Open เพื่อนําเขาโฟลเดอร (รวมถึงโฟลเดอรยอย) หรือไฟลที่เลือก

การเรยีกดูเสนแบงเวลา

เมื่อคุณเริ่มตน Nokia Lifeblog บนคอ

รายการตางๆ ในหนาจอ Timeline แล

คือการจับตัวเลื่อนแลวเลื่อนไปดานหน

คือใหคลิกที่แถบเวลาเพื่อเลือกวันที่ ใ

ขอมูลเพิ่มเติม

สําหรับขอมูลเพิ่มเติมเกี่ยวกับบริการเ

Lifeblog โปรดเยี่ยมชมที่ www.nokia

Nokia Lifeblog PC เพื่อเปดวิธใีช No

Nokia PC Su

Nokia PC Suite เปนชุดของแอปพลิเค

Nokia N73

ในการติดตั้งและใชงาน Nokia PC Su

ระบบปฏิบัติการ Microsoft Windows

สายเคเบิลขอมูล USB หรือการเชื่อมต

คุณตองติดตั้งชุดโปรแกรมนี้ลงคอมพ

สําหรับขอมูลเพิ่มเติม โปรดดูที่แผนซีด

คูมือผูใชฉบับสมบรูณสําหรับ Nokia P

อิเล็กทรอนิกสบนแผนซีดีรอม สําหรับ

เวอรชั่นลาสุดของ Nokia PC Suite โป

http://www.nokia-asia.com/lifeblog
http://www.nokia-asia.com/pcsuite
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shop Album Starter 

r Edition 3.0 ชวยใหคุณคนหา แกไข และแบงปน

ิวเตอรที่ใชรวมกันได คุณสามารถใช Starter 

หคุณคนหาไดงาย

ิจิตอลทั้งหมดในที่ที่เดียว

ยดาย

ผานอีเมล พิมพที่บาน หรือสงไปยังโทรศัพท

hop Album Starter Edition จากแผนซีดีรอม

นคอมพิวเตอรที่ใชรวมกันได Starter Edition 

าร Microsoft Windows 2000 หรือ XP, Nokia PC 

รเชื่อมตอระหวางโทรศัพทกับคอมพิวเตอร และ 

กวาเพื่อดูหรือแกไขคลิปวิดีโอ 

นซีดีรอมที่มาพรอมกับโทรศัพท หากเครื่องของคุณ

ุณสามารถติดตั้งแอปพลิเคชั่นนี้ไดจาก 

nload ทําตามคําแนะนําการติดตั้งบนหนาจอ
สำ
ห
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บางแอปพลิเคชั่นที่มีประโยชนใน Nokia PC Suite คือ:

Get Connected—เพื่อเชื่อมตออุปกรณกับคอมพิวเตอรที่ใชรวมกันไดในครั้งแรก

Nokia PC Sync—เพื่อซิงโครไนซรายชื่อ ปฏิทิน สิ่งที่ตองทํา และรายการบันทึก 

ระหวางโทรศัพทของคุณกับตัวจัเการขอมูลสวนบุคคลบนคอมพิวเตอรที่ใชงาน

รวมกันได (PIM) เชน Microsoft Outlook หรือ Lotus Notes และเว็บบุคมารค

ระหวางโทรศัพทของคุณกับเบราเซอรที่ใชงานรวมกันได

Content Copier—เพื่อสํารองขอมูลจากโทรศัพทหรือเรียกคืนขอมูลที่จัดเก็บไว

จากคอมพิวเตอรมาไวที่โทรศัพท

Nokia Phone Browser—เพื่อจัดการเนื้อหาของโฟลเดอรของโทรศัพทผาน 

Windows Explorer

Nokia Audio Manager—เพื่อสรางและจัดการไฟลเพลงดิจิตอลบนคอมพิวเตอรที่

ใชงานรวมกันได และโอนยายไฟลเพลงลงในอุปกรณที่ใชรวมกันได

Image Store—เพื่อจัดเก็บรูปภาพและวิดีโอจากโทรศัพทลงคอมพิวเตอร

ที่ใชงานรวมกันได

One Touch Access—เพื่อสรางการเชื่อมตอเครือขายโดยการใชโทรศัพทเปนโมเด็ม

ขอมูลเพิ่มเตมิ

สําหรับขอมูลเพิ่มเติม และหากตองการดาวนโหลดเวอรชั่นลาสุดของ 

Nokia PC Suite โปรดเยี่ยมชมที่ www.nokia-asia.com/pcsuite

Adobe Photo
Edition 

Adobe Photoshop Album Starte

รูปถายไดโดยงายผานเครื่องคอมพ

Edition ในเวอรชั่นนี้เพื่อ:

• ใชแท็กจัดระเบียบรูปถายเพื่อใ

• ใชหนาจอปฏิทินเพื่อดูรูปถายด

• แกไขรูปถายที่มีตําหนิอยางงา

• แบงปนรูปถายไดหลายวิธี: สง

เคลื่อนที่ที่ใชรวมกันได

การตดิตัง้

ติดตั้งแอปพลิเคชั่น Adobe Photos

ที่จัดเตรียมมาพรอมกับอุปกรณลงใ

จําเปนตองใชรวมกับระบบปฏิบัติก

Suite 6.5 หรือใหมกวาเพื่อสรางกา

Apple QuickTime 6.5.1 หรือใหม

เลือกใช Nokia PC Suite ไดจากแผ

ยังไมไดติดตั้ง Apple QuickTime ค

www.apple.com/quicktime/dow

http://www.nokia-asia.com/pcsuite
http://www.apple.com/quicktime/download
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นยาย ไฟลที่เลือกทั้งหมดจะถูกนําเขาไปยัง 

สรางไวใน Gallery 

ัตโนมัติลงใน Starter Edition และระบุเปนแท็ก

หลังจากที่ไดโอนยายไฟลไปไวที่ Starter 

ลิปวิดโีอจากคอมพิวเตอร

แกไขแลวกลับไปยังโทรศัพท:

ดวยสายเคเบิลขอมูล USB ที่ใชงานรวมกันได 

tion

ารโอนยายไปยังโทรศัพท

เลือก Send to Mobile Phone

ตามวนัที่

ตามวันที่ใหโดยอัตโนมัติเพื่อใหงายตอ

บงออกเปนสองวิธี: ที่เก็บรูปถายและ

ูปถาย:

ลัด ใหเลือกเดือนของรูปถายที่คุณตองการ

งในที่เก็บรูปถาย
ลิขสทิธิ์ © 2007 Nokia สงวนลิขสทิธิ์

การโอนยายรูปถายและคลปิวดิีโอจาก Nokia N73 

ลงคอมพิวเตอร

วิธีโอนยายรูปถายจากโทรศัพทไปยัง Starter Edition แบงออกเปนสองวิธี

การโอนยายรูปถายและคลิปวิดีโอไปยังคอมพิวเตอรที่ใชรวมกันไดโดยอัตโนมัติ:

1 เชื่อมตอโทรศัพทกับคอมพิวเตอรที่ใชรวมกันไดผานสายเคเบิล USB 

ที่ใชงานรวมกันไดที่มาพรอมกับโทรศัพท บนเครื่องคอมพิวเตอร กลองโตตอบ 

Adobe Photo Downloader จะเปดขึ้น และไฟลภาพและไฟลวิดีโอใหมที่จับไว

ตั้งแตการโอนยายลาสุดจะถูกเลือกโดยอัตโนมัติ

2 หากตองการเริ่มการโอนยาย ใหคลิก Get Photos ไฟลที่เลือกทั้งหมดจะถูก

นําเขาไปยัง Starter Edition อัลบั้มใดๆ ที่คุณสรางไวใน Gallery ของโทรศัพท

จะถูกโอนยายโดยอตัโนมัติลงใน Starter Edition และระบุเปนแท็กใหโดย

อตัโนมัติ

3 คุณสามารถเลือกลบไฟลจากโทรศัพทหลังจากที่ไดโอนยายไฟลไปไวที่ Starter 

Edition แลว

หากตองการเปดใชหรือปดใชงานกลองโตตอบ Adobe Photo Downloader 

โดยอัตโนมัติ ใหคลิกขวาที่ไอคอนบนแถบงาน

การโอนยายรูปถายลงคอมพิวเตอรที่ใชรวมกันไดดวยตนเอง:

1 เชื่อมตอโทรศัพทกับคอมพิวเตอรดวยสายเคเบิลขอมูล USB หรือดวยการ

เชื่อมตอ Bluetooth

2 เริ่มตนแอปพลิเคชั่น Starter Edition

3 ในแถบทางลัด คลิก Get photos > From Camera, Mobile Phone or Card 

Reader กลองโตตอบ Adobe Photo Downloader จะเปดออก

4 คลิก Get Photos เพื่อเริ่มการโอ

Starter Edition อัลบั้มใดๆ ที่คุณ

ของโทรศัพทจะถูกโอนยายโดยอ

ใหโดยอัตโนมัติ 

5 คุณสามารถลบไฟลจากโทรศัพท

Edition แลว

การโอนยายรปูถายและค

ลง Nokia N73

การโอนยายรูปถายและคลิปวิดีโอที่ได

1 เชื่อมตอโทรศัพทกับคอมพิวเตอร

หรือดวยการเชื่อมตอ Bluetooth

2 เริ่มตนแอปพลิเคชั่น Starter Edi

3 เลือกรูปถายและวิดีโอที่คุณตองก

4 คลิก Share ในแถบทางลัด และ

5 คลิก OK

การจัดและคนหารปูถาย

Starter Edition จัดเรียงรูปถายของคุณ

การคนหา วิธคีนหารูปถายตามวันที่แ

หนาตางปฏิทิน

ในการคนหารูปถายโดยการใชที่เก็บร

1 เลือก Photo Well ในแถบทางลัด

2 ในเสนแบงเวลาดานลางแถบทาง

จะดู รูปถายจากเดือนนั้นจะแสด
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รูปถายและขามไปที่เดือนที่ตองการ 

โทรศัพท เพิ่มรูปถายในอัลบั้ม และโอนยาย

ของอัลบั้มจะแสดงเปนแท็กใหมใต Imported tag

:

 Starter Edition จะทําการคัดลอก

แกไข 

ัติ ใหเลือก Auto Smart Fix

 ใหเลือก Fix Photo Window...  

 ความสวาง หรือความคมชัดโดยอัตโนมัติ

รับปรุงสัดสวนหรือเพิ่มจุดเดนใหภาพ

กิดขึ้นจากแฟลชของกลองถายรูป

รั้งที่ไฟลวิดีโอ และคลิก Play ใตหนาตางวิดีโอ

นโทรศัพทเคลื่อนที่:

ือก Edit Mobile Movie คุณดูที่เฟรมแรก

ื่องหมายสีฟาในเสนแบงเวลาดานลางหนาตาง

ลังดูอยู
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การคนหารูปถายโดยใชหนาจอปฏิทิน:

1 เลือก Calendar View ในแถบทางลัด

2 ในหนาจอปฏิทิน ใหเลือกวันพรอมรูปถายเพื่อดูรูปถายทั้งหมดที่ไดถายในวันนั้น

3 เลื่อนจากเดือนหนึ่งไปอีกเดือนหนึ่งดวยปุมลูกศรที่ดานบนสุดของปฏิทิน

การจดัการและคนหารูปถายโดยการใชแทก็

คนหารูปถายโดยการใชแท็กคําสําคัญที่ขึ้นอยูกับ คน สถานที่ เหตุการณ 

และลักษณะพิเศษอื่นๆ ของรูปถาย เมื่อคุณแท็กรูปถาย คุณไมจําเปนตองจําชื่อไฟล 

วันที่ หรือโฟลเดอรสําหรับแตละรูป

คลิก Organize ในแถบทางลัดเพื่อเปดหนาตาง Tag 

การสรางแท็กของคุณเอง:

1 คลิก New ในหนาตาง Tag และเลือก New Tag

2 ในกลองโตตอบ Create Tag ใหใชเมนู Category 

เพื่อเลือกประเภทยอยที่คุณตองการทํารายการแท็กไวขางใต

3 ในกลองขอความ Name ปอนชื่อที่คุณตองการตั้งใหกับแท็ก

4 ในกลองขอความ Note ปอนขอมูลที่คุณตองการเพื่อเพิ่มเติมเกี่ยวกับแท็ก

5 คลิก OK

แท็กปรากฏในหนาตาง Tag ภายใตประเภทหรือประเภทยอยที่คุณเลือกไว

ในการแนบแท็กไปยังรูปถาย ใหลากแท็กจากหนาตาง Tag มาไวที่รูปถาย

ในที่เก็บรูปถาย

หากตองการคนหารูปถาย ใหคลิกสองครั้งที่แท็กในหนาตาง Tag การคนหาจะ

คนหารูปถายทั้งหมดที่เจาะจงตามแท็ก

หากตองการปรับลดจํานวนชวงของ

ใหคลิกที่แถบในเสนแบงเวลา 

หากคุณตองการสรางอัลบั้มใหมบน

รูปถายไปยัง Starter Edition ขอมูล

การแกไขรูปถาย

การแกไขปญหาทั่วๆ ไปของรูปถาย

1 เลือกรูปถายในที่เก็บรูปถาย

2 คลิก Fix photo ในแถบทางลัด

ไฟลรูปถายตนฉบับเพื่อทําการ

ในการแกไขรูปถายโดยอัตโนม

ในการแกไขรูปถายดวยตนเอง

และทําตามขั้นตอนตอไปนี้: 

General—เลือกแกไขสี ระดับ

Crop—ครอบตัดรูปถายเพื่อป

Red Eye—แกไขจุดตาแดงที่เ

การเลนและแกไขวิดโีอ

หากตองการเลนวิดีโอ ใหคลิกสองค

การแกไข จัดเรียงใหม และลบฉากใ

1 คลิกขวาไฟลภาพยนตร และเล

ของวิดีโอในหนาตางวิดีโอ เคร

วิดีโอเปนตัวระบุเฟรมที่คุณกํา
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2 หากตองการเลน พักชั่วคราว หยุด ไปที่จุดเริ่มตน หรือไปที่จุดสิ้นสุด 

ใหใชปุมควบคุมดานลางหนาตางวิดีโอ หากตองการเลื่อนไปมาภายในวิดีโอ 

ใหลากเครื่องหมายสีฟาในเสนแบงเวลา

3 หากตองการเลือกไฟลวิดีโอเฉพาะชวงที่ตองการเพื่อครอบตัด จัดเรียงใหม 

หรือลบ ใหทําตามขั้นตอนตอไปนี้:

• ลากมือจับสําหรับเลือกที่อยูที่จุดเริ่มตนและจุดสิ้นสุดของเสนแบงเวลา

• ในการทําเครื่องหมายที่เวลาเริ่มตนของการเลือก ใหกด Shift คางไวและคลิก

ในเสนแบงเวลา ในการทําเครื่องหมายเวลาสิ้นสุด ใหกด Ctrl คางไวและ

คลิกในเสนแบงเวลา

หลังจากที่คุณไดเลือกเซ็กชั่นแลว คุณสามารถลากบารของการเลือก

ในเสนแบงเวลา

4 หากตองการลบสวนที่เลือกไวของวิดีโอ ใหคลิกปุม Delete Selection 

ในแถบเครื่องมือหากตองการครอบตัดสวนที่เลือกและลบสวนอื่น

ที่อยูดานนอกทิ้ง ใหคลิกปุม Trim Selection ในแถบเครื่องมือ

ในการคัดลอกสวนที่เลือกและวางสวนที่เลือกลงในตําแหนงอื่น 

ใหคลิกปุม Copy Selection ในแถบเครื่องมือ 

ลากเครื่องหมายสีฟาในเสนแบงเวลาไปยังตําแหนงที่ตองการ และคลิกปุม Paste

ขอมูลเพิ่มเตมิ

สําหรับวิธีใชเพิ่มเติมเกี่ยวกับฟงกชันของโปรแกรม ใหเลือก Help > Adobe 

Photoshop Album Starter Edition 3.0 Help... ในเมนูหลัก

สําหรับขอมูลเพิ่มเติมเกี่ยวกับ Starter Edition โปรดเยี่ยมชมที่ www.adobe.com/

products/photoshopalbum/starter.html

http://www.adobe.com/products/photoshopalbum/starter.html
http://www.adobe.com/products/photoshopalbum/starter.html
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